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      Availability

      
      
         
         	Create Personal Status Message

         
         	Locations

         
      

      
      
      
         
      

      
      
      
   
      
      
      Create Personal Status Message

      
         
            
               

            
 
            		
            You can create personal status messages to replace the default messages and tell your contacts what you are doing at a glance.

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select the status message field on the main window.
               

               
               
                  	Step 2  
                     
                  
                  	Enter a message to display.
               

               
               
                  	Step 3  
                     
                  
                  	Press the Return key on your keyboard. 
                     Cisco Jabber displays your personal status message.

                     
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Locations

      
      
         
         	Enable Locations

         
         	Add a Location

         
         	Edit a Location

         
         	Remove a Location

         
         	Reassign Location

         
      

      
      
      
         
      

      
      
      
   
      
      
      Enable Locations

      
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select Jabber > Preferences.
               

               
               
                  	Step 2  
                     
                  
                  	In the Preferences window, select the Locations tab.
               

               
               
                  	Step 3  
                     
                  
                  	Select Enable Locations.
               

               
               
                  	Step 4  
                     
                  
                  	(Optional) Select Tell me when new locations are detected. You are alerted when the client detects a new location.
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Add a Location

      
         
            
               

            

            You can create a location for your contacts to see.

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select Jabber > Preferences.
               

               
               
                  	Step 2  
                     
                  
                  	In the Preferences window, select the Locations tab.
               

               
               
                  	Step 3  
                     
                  
                  	Select the + icon. The Create Location window opens.
                  
               

               
               
                  	Step 4  
                     
                  
                  	Select Share this location if you want your contacts to see your location.
               

               
               
                  	Step 5  
                     
                  
                  	In the Name and Address fields, enter information about your location. 
               

               
               
                  	Step 6  
                     
                  
                  	Select Create.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Edit a Location

      
         
            
               

            

            You can edit the locations you have created to add additional information.

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select Jabber > Preferences.
               

               
               
                  	Step 2  
                     
                  
                  	In the Preferences window, select the Locations tab.
               

               
               
                  	Step 3  
                     
                  
                  	In the My Locations window, select a location from the list and select the pen or edit icon to edit your location details.
               

               
               
                  	Step 4  
                     
                  
                  	Update your location information and select Save.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Remove a Location

      
         
            
               

            

            You can remove any location that you configure.

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select Jabber > Preferences
               

               
               
                  	Step 2  
                     
                  
                  	In the Preferences window, select the Locations tab.
               

               
               
                  	Step 3  
                     
                  
                  	In the My Locations window, select the location that you want to remove.
               

               
               
                  	Step 4  
                     
                  
                  	Select the - icon. The location is removed from the list.
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Reassign Location

      
         
            
               

            

            You can reassign your current network location to a location you have already created.

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select Jabber > Preferences.
               

               
               
                  	Step 2  
                     
                  
                  	In the Preferences window, select the Locations tab.
               

               
               
                  	Step 3  
                     
                  
                  	In the My Locations window, select a location from the list and then select the Reassign button.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Contacts

      
      
         
         	Configure Mac Address Book Plug-in

         
         	Add Directory Groups

         
      

      
      
      
         
      

      
      
      
   
      
      
      Configure Mac
         	 Address Book Plug-in
      

      
         
            
               

            
 
            		
            Configure the Mac
               		  Address Plug-in option to allow users to dial contacts using Cisco Jabber
               		  directly from the Mac Address Book. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select 
                        			 Jabber >  Install Mac Address Book
                              				  Plug-in. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Select 
                        			 Jabber > 
                              				  Preferences > 
                              				  General >  Enable Mac Address Book integration,
                        			 restart the client for this to take effect. 
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Add Directory
         	 Groups
      

      
         
            
               

            

            		
            You can add a directory group into your contact list.
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select 
                        			 Jabber > Contacts > New
                              				  Directory Group
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Enter the name of the directory group.
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Select 
                        			 OK.
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Chats

      
      
         
         	Start a Group Chat

         
         	Transfer Files

         
         	Set Privacy Options

         
         	Send a Broadcast Message

         
         	Chat Rooms

         
      

      
      
      
         
      

      
      
      
   
      
      
      Start a Group Chat

      
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select Jabber > File > New Group Chat. 
               

               
               
                  	Step 2  
                     
                  
                  	Enter the contacts you want to invite in the People field. 
               

               
               
                  	Step 3  
                     
                  
                  	Enter the subject for your group chat. 
               

               
               
                  	Step 4  
                     
                  
                  	Select Invite. 
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Transfer Files

      
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	 In a chat window you can select the file transfer icon [image: ../images/283081.jpg]. 
               

               
               
                  	Step 2  
                     
                  
                  	Select the file to transfer. 
               

               
               
                  	Step 3  
                     
                  
                  	Select Send. 
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Set Privacy Options

      
         
            
               

            

            You can specify privacy options to control who can see your status and send you messages. When you block a contact, that person
               cannot view your availability status or send you instant messages. 
            

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select Jabber > Preferences > Privacy. 
               

               
               
                  	Step 2  
                     
                  
                  	Select your privacy preferences in the Policies section. 
               

               
               
                  	Step 3  
                     
                  
                  	Close the Preferences window to apply the changes. 
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Send a Broadcast Message

      
         
            
               

            

            You can easily send a single message to a group of your contacts. Recipients receive broadcast messages in the same way as
               a 1:1 chat.
            

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	From your contact list, select all the contacts that you want to sent a broadcast message.  
                      If you want to send a message to an entire group, select the header for the contact group.

                     
                  
               

               
               
                  	Step 2  
                     
                  
                  	Right-click on the selected contacts and select Send broadcast message. The Send broadcast message window displays.
                  
               

               
               
                  	Step 3  
                     
                  
                  	Enter your message in the text box. If you want to add more people to the broadcast message, you can search for them in the People field and add them.
                  
               

               
               
                  	Step 4  
                     
                  
                  	Select Send.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Chat Rooms

      
         Chat rooms are enabled if there is a Chat Rooms icon on your main window. You use chat rooms to join or read discussions on
            the theme of the room with the other chat room members.
         

         
      

      
      
      
         
         	Join in Chat Rooms

         
         	Participate in Chat Rooms

         
         	Search Chat Rooms

         
      

      
      
      
         
      

      
      
      
   
      
      
      Join in Chat Rooms

      
         
            
               

            

            Joining a chat room allows you to participate in the conversation or read what is being said, where multiple chat room members
               share information in a common chat window. All of the rooms that you are a member of are listed in your My rooms tab. If an administrator adds you to a chat room, it is displayed immediately in your My rooms tab.
            

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Click the Chat rooms icon in the main window, and select All Rooms.
               

               
               
                  	Step 2  
                     
                  
                  	Browse for a room, which are listed alphabetically. If a room is restricted to specific members, you cannot join the room unless you are added by an administrator. For the restricted
                     rooms that you are not a member of, you see a lock icon instead of the Join button.
                  
               

               
               
                  	Step 3  
                     
                  
                  	Select Join beside the room that you want to join. The rooms where you are already a member have a checkmark beside them.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Participate in Chat Rooms

      
         
            
               

            

            When you are added as a member to a chat room, you can participate in the persistent chat room and view the discussion history.
               
            

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select the Chat rooms tab.  All the chat rooms that you are a member of are listed. 
                  
               

               
               
                  	Step 2  
                     
                  
                  	Double-click on the room that you want to enter. 
               

               
               
                  	Step 3  
                     
                  
                  	View the current participant list on the right side of the chat window. 
               

               
               
                  	Step 4  
                     
                  
                  	Read the discussion and enter your own chat messages. The history of the conversation is persistent. When you exit the chat
                        room and close the client, you can return to the conversation in that room. When you return to the chat room, you can view
                        the messages that were sent by other members while you were not logged in. From the chat room, select Show More to view older messages. 
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Search Chat Rooms

      
         
            
               

            

            You can search for instances of keywords in your chat rooms. Only rooms that you are a member of will be searched. 

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Enter a search term in the Search or call field in the client. 
               

               
               
                  	Step 2  
                     
                  
                  	Select Search chat room messages option in the list.  A search results window is displayed. 
                  
               

               
               
                  	Step 3  
                     
                  
                  	Select Enter to go to the chat room in the list or you can refine your search using the advanced search icon. 
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Calls

      
      
         
         	Start a Jabber to Jabber Call

         
         	Change Audio Devices

         
         	Create Ad-hoc Conference Call

         
         	Forward Calls

         
         	URI Dialing

         
         	Transfer an Active Call

         
      

      
      
      
         
      

      
      
      
   
      
      
      Start a Jabber to
         	 Jabber Call
      

      
         
            
               

            
 
            		
            You can make a
               		  call to another Cisco Jabber client using Jabber to Jabber calls. There are
               		  some differences using Jabber to Jabber calls: 
               		
               
                  	 
                     			 
                     You can make a
                        				Jabber to Jabber call with only one contact at a time. 
                        			 
                     

                     
                     		  
                  

                  
                  	 
                     			 
                     When you are
                        				on a Jabber to Jabber call, if you call another contact your ongoing call will
                        				end. 
                        			 
                     

                     
                     		  
                  

                  
                  	 
                     			 
                     When you start
                        				a Jabber to Jabber call with a contact and your contact starts a Jabber to
                        				Jabber call with you at the same time, your call is connected and you don't get
                        				any incoming call notice. 
                        			 
                     

                     
                     		  
                  

                  
               

               
               		
            

            
            	 
         

         
         Before You Begin
               

            

            		
            This feature is
               		  enabled by your administrator. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select the
                        			 call icon for your contact. For example in the contact list or in the chat
                        			 window. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Select 
                        			 Jabber
                           				Call from the menu. 
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Change Audio
         	 Devices
      

      
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	 Plug in your
                        			 headset or other audio device to the appropriate USB port.
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Select 
                        			 Jabber
                           				> 
                           			 Preferences > 
                           			 Audio/Video.
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Select your
                        			 audio device from the drop-down lists after the hardware is recognized.
                        		  
               

               
               
                  	Step 4  
                     
                  
                  	Adjust the
                        			 volume for the audio device.
                        		  
               

               
               
                  	Step 5  
                     
                  
                  	Close the 
                        			 Preferences window to apply the changes.
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Create Ad-hoc
         	 Conference Call
      

      
         
            
               

            
 
            		
            You can create an
               		  ad-hoc conference with your contacts, simply merge your calls to create a
               		  conference call. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Start a call
                        			 with your first contact. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Start a second
                        			 call with another contact, the first call is automatically put on hold. 
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Select 
                        			 More > Merge and the two calls are merged into a conference call. 
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Forward
         	 Calls
      

      
         
            
               

            

            		
            You can forward
               		  calls from Cisco Jabber.
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select 
                        			 Jabber
                           				> 
                           			 Preferences > 
                           			 Calls.
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Select 
                        			 Call
                           				Forward.
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	In the 
                        			 Forward Calls to section, select an option
                        			 from the available list or add a new number.
                        		  
                        	Add a new
                              				  number in the available list by selecting the 
                              				  + (plus) button.
                              				

                        
                        	Enter a phone number, including country and area codes.
                              				

                        
                     

                     
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      URI Dialing

      
          
            		
            You can use URI dialing to make calls and resolve contacts with Uniform Resource Identifiers
               		  (URI). 
               		
            

            
            Users that are connected to Cisco TelePresence Video Communication
               		  Server (VCS), are only accessible using their associated URI. 
               		
            

            
            		
            		
            For example, a
               		  user named Anita Perez has the following SIP URI associated with her directory
               		  number: aperez@example.com. URI dialing enables users to call Anita with her
               		  SIP URI rather than her directory number. 
               		
            

            
            	 
         

         
         
            Imported Contacts from Microsoft Outlook

            Contacts imported
               		  from Microsoft Outlook may contain SIP URIs. For releases prior to Apple OS X
               		  Maverick Version 10.9, the Mac address book may not display some characters,
               		  for example aperez@example.com can display as aperezexamplecom. However, you
               		  can still search and call using these URIs. 
               		
            

            
         

         
      

      
      
      
         
         	Setup SIP URI

         
         	Dialing a Contact using a SIP URI

         
      

      
      
      
         
      

      
      
      
   
      
      
      Setup SIP
         	 URI
      

      
         
            
               

            
 
            		
            You can create a
               		  SIP URI for the contacts in your Mac address book. 
               		
            

            
            	 
         

         
         Before You Begin
               

            
 
            		
            Ensure that you
               		  have configured the Address Book Plug-in for 
               		  Cisco Jabber for Mac.
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select the
                        			 user in your Mac address book and select 
                        			 Edit. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Within the
                        			 phone section of the contact card, add the SIP URI for your contact. 
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Select 
                        			 Done. 
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Dialing a Contact
         	 using a SIP URI
      

      
         
            
               

            
 
            		
            You can call a
               		  contact using their SIP URI. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Enter the
                        			 characters of the URI including the @ symbol and at least two characters after
                        			 the @. For example aperez@ex. 
                        		   The call bricklet will display the results.
                     		  
                  
               

               
               
                  	Step 2  
                     
                  
                  	Select 
                        			 Call in the bricklet, to call the contact using
                        			 their SIP URI. 
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Transfer an Active
         	 Call
      

      
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select the
                        			 more menu icon and select 
                        			 Transfer Call.
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Search for the
                        			 person you are transferring the call to.
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Select the 
                        			 Transfer icon and the call is transferred.
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Meetings

      
      
         
         	Add Meeting Accounts

         
         	Bridge Escalations

         
         	Start a Meeting Using my Personal Room

         
         	Escalate to a Collaboration Meeting Room

         
         	Add DTMF in your Meetings

         
         	Control Far End Cameras

         
      

      
      
      
         
      

      
      
      
   
      
      
      Add Meeting Accounts

      
         
            
               

            

            
            You can add Cisco WebEx sites to Cisco Jabber to quickly start, join, and manage online conferences.

            
            
            
            In cloud-based deployments, you cannot   add a meeting site that is configured for SSO, this site must be created in the Cisco WebEx Administration
                  				  Tool.
            

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	
                        
                        Select Jabber > Preferences > Meetings. 
                     
                        
                           	Note   
                                 
                                 
                           	Sites that are provisioned by your administrator cannot be edited or deleted.
                        

                     

                     
                  
               

               
               
                  	Step 2  
                     
                  
                  	Select the  Meeting Site drop-down list.
               

               
               
                  	Step 3  
                     
                  
                  	Select Edit Meeting Site...  from the drop-down list.
               

               
               
                  	Step 4  
                     
                  
                  	Select the plus (+) button to add a new meetings site.
               

               
               
                  	Step 5  
                     
                  
                  	Enter the required settings in the following fields: 
                     
                        
                           	Site URL

                           
                           	The name of the Cisco WebEx site, for example, cisco.webex.com

                           
                           	Username

                           
                           	Your username

                           
                           	Password

                           
                           	Your password

                           
                        

                        
                     

                     
                  
               

               
               
                  	Step 6  
                     
                  
                  	Select  Apply
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Bridge Escalations

      
      
         
         	Configure Bridge Information

         
         	Create Conference Call Using My Bridge

         
      

      
      
      
         
      

      
      
      
   
      
      
      Configure Bridge Information

      
         
            
               

            

            		
            You can specify an alternative number to use for your conference
               		  calls. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select 
                        			 Jabber > System
                              				  Preferences. 
                        		   The
                     			 preferences window opens. 
                     		  
                  
               

               
               
                  	Step 2  
                     
                  
                  	Select the 
                        			 Calls tab. 
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Select the 
                        			 General tab. 
                        		  
               

               
               
                  	Step 4  
                     
                  
                  	Select 
                        			 Use my
                           				conference service option. 
                        		  
               

               
               
                  	Step 5  
                     
                  
                  	Enter the
                        			 number or the URI for your bridge. 
                        		    
                     			 
                     If your
                        				administrator has added a bridge pattern you won't be able to edit this field. 
                        			 
                     

                     
                     		  
                  
               

               
               
                  	Step 6  
                     
                  
                  	(Optional)
                        			 Enter a Host PIN. 
                        		  
               

               
               
                  	Step 7  
                     
                  
                  	(Optional)
                        			 Enter a Guest PIN. 
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Create Conference
         	 Call Using My Bridge
      

      
         Before You Begin
               

            
 
            		
            You have
               		  configured your bridge information. For more information, see 
               		  Configure Bridge Information.
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	In the group
                        			 chat window, select the call icon to start a conference call. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	You are connected into your bridge and your participants
                        			 are sent an invitation to join your conference call.
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Start a Meeting
         	 Using my Personal Room
      

      
         Before You Begin
               

            
 
            		
            Ensure that 
               		  Use
                  			 Personal Room for all my instant meetings is selected in your 
               		  "Meet
                  			 Now" Settings on Cisco WebEx. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select one or
                        			 more contacts. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Right click
                        			 and select 
                        			 Meet
                           				Now. 
                        		   You are
                     			 connected into your personal room and your participants are sent an invitation
                     			 to join your meeting. 
                     		  
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Escalate to a
         	 Collaboration Meeting Room
      

      
         
            
               

            
 
            		
            You can choose to
               		  create a conference call from your group chat using Cisco Collaboration Meeting
               		  Room (CMR) Cloud.
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Ensure 
                        			 Use my
                           				bridge for conference call option is not selected. For more
                        			 information, see 
                        			 Configure
                           				Bridge Information. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	When you are
                        			 in a group chat with participants, select the call icon. 
                        		   You are
                     			 connected into the conference call and your participants are sent an invitation
                     			 to either enter the meeting using a video link or enter the meeting using Cisco
                     			 WebEx. 
                     		  
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Add DTMF in your
         	 Meetings
      

      
         
            
               

            
 
            		
            You can copy and
               		  paste dual tone multi frequency (DTMF) digits into a conference call. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Copy the
                        			 meeting ID, attendee ID, or PIN from your meeting invitation. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	When in a
                        			 call, select the keypad icon. 
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Paste the
                        			 information directly into the keypad (Command + V). 
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Control Far End
         	 Cameras
      

      
         Before You Begin
               

            
 
            		
             This feature is available to you if it is supported by the system you
               		  are calling, and if it is enabled for you by your administrator. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	After you have started a video call, select the 
                        			 Show Far End Camera Control icon. 
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Use the pan, tilt, and zoom button to control the call. 
                        		  
                        	 For direct
                           				calls to devices, use the controls to pan the camera left or right, tilt the
                           				camera up or down, and zoom the camera in and out. 
                           			 
                        

                        
                        	For calls to
                           				bridges, use the controls to select the conference layout that you want to use.
                           				
                           			 
                        

                        
                     

                     
                     			 
                     You can also use the following keyboard shortcuts to manually
                        				control the camera: 
                        			 
                     

                     
                     		  
                     
                     
                        
                        
                           
                              	Option
                              
                              	Description
                           

                        
                        
                        
                           
                              	Tilt up
                              
                              	 
                                 				  
                                 Up arrow key 
                                    				  
                                 

                                 
                              
                              
                           

                           
                           
                              	Tilt down
                              
                              	 
                                 				  
                                 Down arrow key 
                                    				  
                                 

                                 
                              
                              
                           

                           
                           
                              	Pan left
                              
                              	 
                                 				  
                                 Left arrow key 
                                    				  
                                 

                                 
                              
                              
                           

                           
                           
                              	Pan right
                              
                              	 
                                 				  
                                 Right arrow key 
                                    				  
                                 

                                 
                              
                              
                           

                           
                           
                              	Zoom in
                              
                              	 
                                 				  
                                 Plus sign 
                                    				  
                                 

                                 
                              
                              
                           

                           
                           
                              	Zoom out
                              
                              	 
                                 				  
                                 Minus sign key 
                                    				  
                                 

                                 
                              
                              
                           

                           
                        
                     

                     
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Custom Tabs

      
      
         
         	Create Custom Tabs

         
         	Remove Custom Tabs

         
      

      
      
      
         
      

      
      
      
   
      
      
      Create Custom Tabs

      
         
            
               

            

            You can create custom tabs to show HTML content in the main window.

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select  File > New Custom Tab The Create new custom tab dialog window opens.
                  
               

               
               
                  	Step 2  
                     
                  
                  	Add details for your custom tab in the following fields:
                        	Tab name—Enter an optional name for your custom tab. The name displays when you hover your cursor over the tab.
                        

                        
                        	Page URL—Enter the URL of the content for your custom tab.
                        

                        
                     

                     
                  
               

               
               
                  	Step 3  
                     
                  
                  	Select Create. The custom tab is added to the main window.
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Remove Custom Tabs

      
         
            
               

            

            You can remove the custom tabs that you create.

            
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select the tab to remove.
               

               
               
                  	Step 2  
                     
                  
                  	Select Jabber  > File > Remove Custom Tab..
               

               
               
                  	Step 3  
                     
                  
                  	Select Remove. The tab is removed.
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Accessibility

      
      
         
         	Accessibility Icons

         
         	Keyboard Shortcuts

         
         	Keyboard Navigation

         
      

      
      
      
         
      

      
      
      
   
      
      
      Accessibility Icons

      
          
            		
             Accessibility status
               		  icons use symbols to show availability. 
               		
            

            
            		
            To use accessibility status icons, select 
               		  Jabber > Preferences > Status > Use accessible presence
                     				icons. 
               		
            

            
            		
            The following
               		  table shows standard and accessibility status icons: 
               		
               
               
                  
                     
                        
                           	Standard Icon 
                              				  
                           
                           
                           	Accessibility  Icon 
                              				  
                           
                           
                           	Description 
                              				  
                           
                           
                        

                        
                     
                     
                     
                        
                           	 
                              				  [image: ../images/410531.jpg]
                           
                           	 
                              				  [image: ../images/410534.jpg]
                           
                           	 
                              					 
                              Available 
                                 					 
                              

                              
                              				  
                           
                           
                        

                        
                        
                           	 
                              				  [image: ../images/410532.jpg]
                           
                           	 
                              				  [image: ../images/410535.jpg]
                           
                           	 
                              					 
                              Away 
                                 					 
                              

                              
                              				  
                           
                           
                        

                        
                        
                           	 
                              				  [image: ../images/410533.jpg]
                           
                           	 
                              				  [image: ../images/410536.jpg]
                           
                           	 
                              					 
                              Do Not
                                 						Disturb 
                                 					 
                              

                              
                              				  
                           
                           
                        

                        
                        
                           	 
                              				  [image: ../images/410576.jpg]
                           
                           	[image: ../images/410576.jpg] 
                              				  
                           
                           
                           	 
                              					 
                              Unavailable 
                                 					 
                              

                              
                              				  
                           
                           
                        

                        
                     
                     
                  

                  
               

               
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Keyboard
         	 Shortcuts
      

      
         
            Navigate Hub Window

            		
            		
            To navigate through the tabs on the hub window, select 
               		  Command and the number of the tab. For example,
               		  to navigate to the first tab select 
               		  Command + 1 . 
               		
            

            
            	 
         

         
         
            		
            
            
               
                  
                     
                        	
                           					 
                           Action
                              					 
                           

                           
                           				  
                        
                        
                        	
                           					 
                           Keyboard
                              						access
                              					 
                           

                           
                           				  
                        
                        
                     

                     
                  
                  
                  
                     
                        	
                           					 
                            Add a
                              						contact
                              					 
                           

                           
                           				  
                        
                        
                        	
                           					 
                           COMMAND
                              						+ D
                              					 
                           

                           
                           				  
                        
                        
                     

                     
                     
                        	
                           					 
                            Show
                              						Expanded Contacts View (toggle open and closed)
                              					 
                           

                           
                           				  
                        
                        
                        	
                           					 
                            SHIFT +
                              						COMMAND + T
                              					 
                           

                           
                           				  
                        
                        
                     

                     
                     
                        	
                           					 
                            Show
                              						Offline Contacts (toggle to show and hide)
                              					 
                           

                           
                           				  
                        
                        
                        	
                           					 
                            SHIFT +
                              						COMMAND + H
                              					 
                           

                           
                           				  
                        
                        
                     

                     
                     
                        	
                           					 
                            Bring
                              						the main Cisco Jabber window into focus
                              					 
                           

                           
                           				  
                        
                        
                        	
                           					 
                            COMMAND
                              						+ /
                              					 
                           

                           
                           				  
                        
                        
                     

                     
                  
                  
               

               
            

            
            	 
         

         
      

      
      
      
         
         	Active Call

         
         	Incoming Call

         
         	Instant Messages

         
         	Global Shortcuts

         
         	Voice Messages

         
         	Call

         
      

      
      
      
         
      

      
      
      
   
      
      
      Active Call

      
          
            		
             
               		
               
               
                  
                     
                        
                           	
                              Action 
                                 				  
                              

                              
                           
                           
                           	
                              Keyboard Shortcut 
                                 				  
                              

                              
                           
                           
                        

                        
                     
                     
                     
                        
                           	 
                              End Call 
                                 				  
                              

                              
                           
                           
                           	
                              COMMAND + K 
                                 				  
                              

                              
                           
                           
                        

                        
                        
                           	
                              Mute Audio toggle On/Off

                              
                              				  
                           
                           
                           	
                              OPTION + COMMAND + DOWN ARROW 
                                 				  
                              

                              
                           
                           
                        

                        
                        
                           	
                              Increase Volume

                              
                              				  
                           
                           
                           	
                              UP ARROW
                                 				  
                              

                              
                           
                           
                        

                        
                        
                           	
                              Decrease Volume
                                 				  
                              

                              
                           
                           
                           	
                              DOWN ARROW
                                 				  
                              

                              
                           
                           
                        

                        
                        
                           	
                              Hold 
                                 				  
                              

                              
                           
                           
                           	
                              Access through the menus when the conversation window is active,
                                 					 or TAB or SHIFT+TAB to move through the buttons and objects in the window.
                                 				  
                              

                              
                           
                           
                        

                        
                        
                           	
                              Transfer Call
                                 				  
                              

                              
                           
                           
                           	
                              OPTION + COMMAND + T
                                 				  
                              

                              
                           
                           
                        

                        
                        
                           	
                              Call Control Strip auto-fade toggle On/Off.

                              
                              Only available when VoiceOver is enabled.

                              
                           
                           
                           	
                              COMMAND + OPTION + SHIFT + H

                              
                           
                           
                        

                        
                     
                     
                  

                  
               

               
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Incoming Call

      
          
            		 
            		
             
               		
               
               
                  
                     
                        
                           	Action 
                              				  
                           
                           
                           	Keyboard Shortcut 
                              				  
                           
                           
                        

                        
                     
                     
                     
                        
                           	 
                              					 Answer a  Call 
                              					  
                              				  
                           
                           
                           	COMMAND + L
                           
                        

                        
                        
                           	Decline, Answer
                           
                           	When the Conversation window is in focus, TAB or SHIFT + TAB to move to the Decline or Answer button.
                           
                        

                        
                        
                           	Answer a Call and see the caller ID
                           
                           	
                              
                                 
                                    	
                                       CONTROL + COMMAND + J to open the Cisco Jabber Status Menu

                                       
                                    

                                    
                                    	
                                       DOWN ARROW to move through the menu options and select answer call from xxx-xxx-xxxx.
                                       

                                       
                                    

                                    
                                    	
                                       Press ENTER.

                                       
                                    

                                    
                                 

                                 
                              

                              
                           
                           
                        

                        
                     
                     
                  

                  
               

               
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Instant Messages

      
          
            		 
            		
             
               		
               
               
                  
                     
                        
                           	
                              Action

                              
                              				  
                           
                           
                           	
                              Keyboard Shortcut 
                                 				  
                              

                              
                           
                           
                        

                        
                     
                     
                     
                        
                           	 
                              					 
                              Start a chat with the selected contact.

                              
                           
                           
                           	
                              COMMAND + N

                              
                           
                           
                        

                        
                        
                           	
                              Start a group chat with multiple selected contacts.

                              
                           
                           
                           	
                              OPTION + SHIFT + COMMAND + N

                              
                           
                           
                        

                        
                        
                           	
                                  Switching between chat tabs.

                              
                           
                           
                           	
                              CONTROL + TAB

                              
                           
                           
                        

                        
                        
                           	
                              Close chat.

                              
                           
                           
                           	
                              COMMAND + W

                              
                           
                           
                        

                        
                        
                           	
                              Exit the messaging text entry field.

                              
                           
                           
                           	
                              SHIFT + TAB

                              
                           
                           
                        

                        
                        
                           	
                              Restore default font.

                              
                           
                           
                           	
                              OPTION + SHIFT + COMMAND + T

                              
                           
                           
                        

                        
                        
                           	 
                              Show All Fonts.

                              
                           
                           
                           	
                              COMMAND + T

                              
                           
                           
                        

                        
                        
                           	 
                              Bold

                              
                           
                           
                           	
                              COMMAND + B

                              
                           
                           
                        

                        
                        
                           	
                               Italic

                              
                           
                           
                           	
                              OPTION + COMMAND  + I

                              
                           
                           
                        

                        
                        
                           	 
                              Underline

                              
                           
                           
                           	
                              COMMAND + U

                              
                           
                           
                        

                        
                        
                           	 
                              Bigger

                              
                           
                           
                           	
                              COMMAND  +  + (plus)

                              
                           
                           
                        

                        
                        
                           	 
                              Smaller

                              
                           
                           
                           	
                              COMMAND + - (minus)

                              
                           
                           
                        

                        
                        
                           	 
                              Show Colors

                              
                           
                           
                           	
                              SHIFT + COMMAND + C

                              
                           
                           
                        

                        
                     
                     
                  

                  
               

               
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Global Shortcuts

      
         
            Global keyboard shortcuts when the Cisco Jabber window is in the background.

            
            		 
            		
             
               		
               
               
                  
                     
                        
                           	Action 
                              				  
                           
                           
                           	Keyboard Shortcut 
                              				  
                           
                           
                        

                        
                     
                     
                     
                        
                           	 
                              					 Answer a  Call 
                              					  
                              				  
                           
                           
                           	CONTROL  + COMMAND + L
                           
                        

                        
                        
                           	Dial selected text in an application
                           
                           	SHIFT + COMMAND + 0 (zero) or 
                              COMMAND  + )

                              
                           
                           
                        

                        
                        
                           	Answer a Call and see the caller ID
                           
                           	
                              
                                 
                                    	
                                       CONTROL + COMMAND + J to open the Cisco Jabber Status Menu

                                       
                                    

                                    
                                    	
                                       DOWN ARROW to move through the menu options and select answer call from xxx-xxx-xxxx.
                                       

                                       
                                    

                                    
                                    	
                                       Press ENTER.

                                       
                                    

                                    
                                 

                                 
                              

                              
                           
                           
                        

                        
                     
                     
                  

                  
               

               
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Voice Messages

      
          
            		 
            		
             
               		
               
               
                  
                     
                        
                           	Action 
                              				  
                           
                           
                           	Keyboard Shortcut 
                              				  
                           
                           
                        

                        
                     
                     
                     
                        
                           	 
                              					 Delete voice message
                           
                           
                           	DELETE
                           
                        

                        
                        
                           	Empty voice message trash
                           
                           	OPTION + COMMAND + DELETE
                           
                        

                        
                        
                           	Play voice message (toggle play and pause)
                           
                           	OPTION + COMMAND + P
                           
                        

                        
                        
                           	View voice message tab
                           
                           	COMMAND + 4
                           
                        

                        
                     
                     
                  

                  
               

               
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Call

      
          
            		 
            		
             
               		
               
               
                  
                     
                        
                           	Action 
                              				  
                           
                           
                           	Keyboard Shortcut 
                              				  
                           
                           
                        

                        
                     
                     
                     
                        
                           	 
                              					 New Call 
                              					  
                              				  
                           
                           
                           	SHIFT + COMMAND + N
                           
                        

                        
                        
                           	Redial
                           
                           	COMMAND + R
                           
                        

                        
                        
                           	Place a call to the selected contact in the contact list
                           
                           	OPTION + COMMAND + C
                           
                        

                        
                     
                     
                  

                  
               

               
               		
            

            
            	 
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Keyboard Navigation

      
         
            Use COMMAND + number to move to each tab. For example to move to the first tab, use COMMAND + 1. Use the Tab key and arrow
               keys to navigate through the main window.
            

            
         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Troubleshooting

      
      
         
         	Verify Audio and Video Device Settings

         
         	Check the Connection Status

         
         	Report a Problem

         
      

      
      
      
         
      

      
      
      
   
      
      
      Verify Audio and Video Device
         	 Settings
      

      
         
            
               

            

            		
            If you have an issue with your audio or video devices, you can verify
               		  the selected devices. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select 
                        			 Jabber > Preferences.
                        		   The 
                     			 General Preferences window opens.
                     		  
                  
               

               
               
                  	Step 2  
                     
                  
                  	Select 
                        			 Audio/Video.
                        		   The 
                     			 Audio/Video Preferences window opens.
                     		  
                  
               

               
               
                  	Step 3  
                     
                  
                  	Verify the device settings.
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Check the
         	 Connection Status
      

      
         
            
               

            
 
            		
            If there is an
               		  issue with a feature, you can check your connection status. For example, if you
               		  cannot access your voice messages. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select 
                        			 Help > Show Connection
                              				  Status. 
                        		   The
                     			 server connection status window opens. 
                     		  
                  
               

               
               
                  	Step 2  
                     
                  
                  	For each
                        			 server listed, verify that the status displayed is 
                        			 Connected. 
                        		  
                        	If the server connections
                           				are all showing as connected, select 
                           				Copy to capture the information and send to your
                           				system administrator. 
                           			 
                        

                        
                        	If a server connection
                           				shows a different status, select 
                           				Open
                              				  Accounts to verify the settings are correct for the account. If the
                           				issue persists report a problem to your system administrator. 
                           			 
                        

                        
                     

                     
                  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      Report a Problem

      
         
            
               

            

            		
            If you encounter a problem with Cisco Jabber, you can create a problem
               		  report to assist your system administrator resolve your issue.
               		
            

            
            		
            The Problem Reporting Assistant guides you through the reporting
               		  process. The problem report generated contains logs from your computer. 
               		
            

            
            	 
         

         
         
            

         
Procedure

         
            
               
                  	Step 1  
                     
                  
                  	Select 
                        			 Help > Report a
                              				  Problem.
                        		  
               

               
               
                  	Step 2  
                     
                  
                  	Enter information on the issue and select 
                        			 Continue.
                        		  
               

               
               
                  	Step 3  
                     
                  
                  	Select 
                        			 Generate to create the problem report.
                        		  
               

               
               
                  	Step 4  
                     
                  
                  	Select 
                        			 Email to create an email that you can
                        			 send to your system administrator.
                        		  
               

               
            

         

         

         
      

      
      
      
         
      

      
      
      
   
      
      
      

      
         

         
         
            
            THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS
               MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND
               RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED
               WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL
               RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS. 
               
            

            
            
            THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT
               ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE
               INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE
               LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY. 
               
            

            
            
            The Cisco implementation of TCP header compression is an adaptation of
               a program developed by the University of California, Berkeley (UCB) as part of
               UCB's public domain version of the UNIX operating system. All rights reserved.
               Copyright © 1981, Regents of the University of California.
               
            

            
            
            NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND
               SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS" WITH ALL FAULTS. CISCO AND THE
               ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING,
               WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
               AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE
               PRACTICE. 
               
            

            
            
            IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT,
               SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION,
               LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO
               USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE
               POSSIBILITY OF SUCH DAMAGES. 
               
            

            
            Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone
               numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown
               for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and
               coincidental.
            

            
            
         

         
         
            
             Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries.
               To view a list of Cisco trademarks, go to this URL: http:/​/​www.cisco.com/​go/​trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply
               a partnership relationship between Cisco and any other company. (1110R)
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